
Welcome 

Welcome to wpvsword.com.  This site is devoted to comparing Microsoft Word with Corel WordPerfect (as you would imagine).  A 
point system is used to award points to each program's features and abilities, depending upon which is better and/or easier to work 
with. 

TIP!  Please use Full Screen Mode (F11) to view this site 

You may prefer to 'jump' straight to the comparison or you may like a bit of background information.  If your preference is the former, 
then please click HERE to review the Legend, so that you understand the System Used.  Alternatively, if you would like a bit of 
background information pertaining to the difference between WordPerfect and Word (in addition to why I created this site), please 
read on.  Either way, you can navigate the site using the image map to your left. 

Understanding the Fundamental difference between Word and WordPerfect 

To start, before I discuss my interest in WordPerfect, you should understand that there is a significant difference between the 2 
programs: Word is Object-Oriented, WordPerfect is Stream-Formatted. 

What does this mean?  Well, this basically means that when you make a change to a WordPerfect document, the changes take 
effect 'From THAT Point Forward'.  You generally don't need to select an Object (e.g., a word, sentence, or a paragraph) in order to 
effect a change.  You can simply select a color, a font, a paragraph style, etc, and the whole document will be affected (as stated, 
from that point forward).  Stream Formatted is, as you can imagine, like a stream of formatting that flows throughout the document. 

Word, on the other hand, is object-oriented.  Every letter, word, sentence, and paragraph is an object.  To help people grasp the 
concept of object-oriented programming, Microsoft uses a simple analogy: oranges.  You can imagine that an orange has several 
attributes that can be changed: it has a color, a texture, etc.  It can be changed by being painted or peeled.  Therefore, once you 
understand that you need to select an object when you want to manipulate your Word document, you begin to understand how to 
work in Word. 

I'll illustrate these concepts further by using a real-life example that you would commonly encounter when word processing: 

Say you had typed a report in the following style: 

Text Times New Roman 12 Font Left Justified 
Headings Arial 14 Font Centered 

If you typed the report in WordPerfect and you wanted to amend everything but the Headings to Courier, 11 pt, Fully Justified, you 
would press ctrl+home to go to the top of the document and make 3 formatting changes (3 clicks); your entire report (excluding 
Headings, which are Styles) would then follow these changes. 

If you typed the same report in Word and you wanted to make the same changes, you would have to do one of the following: 

• Go to Format » Style » Modify » Format » Font (and Paragraph), then change the Normal (or predefined) Style  
• 'Select All', make these changes, then modify Headings Styles  
• Create a complex search to amend these formatting changes  
• Go through and change each paragraph individually using the Format Painter  

NOTE: A feature in Word 2003 (introduced in WordXP) provides a quicker way to achieve this, but the concept remains the same, 
i.e., objects need to be selected and changed as opposed to the document being amended 'From This Point Forward'. 

I outlined the difference between the two programs primarily because I believe that WordPerfect's stream-formatting makes it an 
easier program to work with.  It will also help you to understand why certain tasks are easier to accomplish in WordPerfect as you 
read through this comparison.  Finally, it was one of the aspects of WordPerfect that made me start to fall in love with it, which in turn 
led to my creating this site   . . .  and that leads nicely into the Background.  Again, you may be interested in knowing what drove me 
to create this site.  If so, the Background follows.  Alternatively, if you wish to move on to the comparison, please read the Legend 
below and then navigate the site using the Image Map to your Left. 

Background 

MS Word 6.0 was the first Windows word processor I ever used.  At the time, I worked in a Bank, and I was happy that I didn't have to 
use it very often.  I hated that it wasn't WYSIWYG.  I found that vexatious (and still do).  In later years, I changed careers, moving to 
I.T.  Again, Word was the program I used (and received all my training in).  Whereas before I didn't like it, now I hated it.  I found that 
accomplishing (what I believed to be) simple tasks was unnecessarily difficult, and I was often exasperated by its inadequacies.  I 
then moved to a new company; that company used WordPerfect.  What a joy!  Everything that I hated in Word was suddenly easy to 
accomplish in WordPerfect.  In addition, it was a true WYSIWYG program.  I then found Reveal Codes, and my conversion was 
complete.   



Microsoft produced a White Paper (Word 97: Life after Reveal Codes), which tried to explain why you don't need Reveal Codes in 
Word , but it was nothing more than a lame attempt to justify the fact that Word can't produce the equivalent of Reveal Codes. 

"Word is based on a hierarchical formatting system that allows the user to format based on the entire document, a section, a 
paragraph, or even character.  The hierarchical architecture of Word does not allow for stream-based formatting like in WordPerfect". 

NOTE: In complete contradiction to this, Word XP subsequently introduced a feature called 'Reveal Formatting' (in response to 
people decrying the fact that Word lacked a feature similar to Reveal Codes).  You can read my thoughts on that in the comparison!  
:) 

Anyway, when I added Reveal Codes to WordPerfect's other features, I became a devotee of WordPerfect; this feature alone is one 
of the main reasons WordPerfect has obtained such a devoted following. 

Personally, I found this program amazing.  Instead of wanting to throw my PC out the window, I was actually enjoying working with 
this program!  It made my life easier, and I was continually astounded by the program's power AND ease of use. 

I then bought a new PC and wanted Excel, so I purchased MSOffice 97 OEM with it; when I would come home and work on Reports 
or Assignments for courses I was doing, I would use Word 97.  Grrrr.  I hated it; Word 97 was just as bad as Word 6.0 and Word 7.0.  
I wished I could install WordPerfect 6.1 (which I was using at work) and use that instead of Word 97, but at that time, I was unaware 
that Corel allowed you to install a copy at work and at home.  In total frustration, I took the plunge and went out and bought 
WordPerfect 8.0.  Wow!  I thought WP6.1 was good?  WP8 introduced *so* many fantastic features that I went all-out trying to get my 
company to upgrade, which they did, but they waited for the soon-to-be-released (at that time) Version 9. 

Then, one day, I had a discussion with someone (who worked in the same building) who loved Word.  Stunned, I mentally started to 
go through all the things that WordPerfect could do that Word couldn't (as well as the things that were so much easier in WP).  At 
that point, I resolved to make a website comparing the 2 programs.  My first comparison went online approximately 4 years ago, and 
since then, I've updated it to compare the 2 programs when a new version is released. 

That's the background.  Hope it wasn't boring!  I'm sure you're itching to move on to the actual comparison, so I won't ramble any 
longer. 

Overview/Legend 

The Comparison is broken down by Menu Item.  Each Item is compared and assigned points based on which is better. 

The Point System 
1 Point Where a feature is very similar in both programs, each program receives a point.  If the feature only exists in one 

program, then that program gets the point 

5 Points Using the explanations above, a program may receive 5 points for a particular feature IF that feature is significantly 
better AND/OR a really good productivity-enhancing feature 

10 Points Using the explanations above, a program may receive 10 points for a particular feature IF that feature is phenomenal—
i.e., a feature that is used every day and genuinely helps a user be more productive in a significant way 

 

The Icons: 

 

If Word has introduced a feature that WordPerfect previously had, WordPerfect will have an icon below the points 
awarded 

 
Similarly, if WordPerfect has introduced a feature that Word has had in previous versions, Word will have an icon below 
the points it is awarded. 

Example: Under Drawing, Word will have 4 Word icons, meaning that its Drawing features were at least 4 versions ahead of 
WordPerfect, i.e., Word users benefited for 8 years with a feature that WordPerfect lacked.   

 

Color-Coding 
Each program has introduced or enhanced features with this release.  To help you identify features that are new or enhanced in 
each version, the table-row is colored green. 

 
 
File Menu Item WP Word Comments 
Word & WP: New Document WP: 1  In WP, a new document is always on the screen. 

WP: New from Project  
Word: New 

WP: 5 Word: 1 A big improvement for Word and WordPerfect is the number of Templates 
available. 

Both programs now give you the option of obtaining Projects/Templates 
from the Web.  Where WP has always excelled is the ability to edit, copy, 



move, and create Categories for your templates.  You can also (easily) Build 
Prompts (click HERE to see an example) for your Templates, so that all the 
correct information is entered anywhere in your document (in the correct 
order). 

WP: New XML Document  
Word: Via the 'New' Task Pane 

WP: 1 Word: 5 Both Corel and MS made their new Office Suites focus heavily on XML, but 
where WP has simply enhanced its SGML/XML facility and allowed you to 
save as XML, Microsoft has made XML transparent to the user, which 
means it's just so simple to use.  Many people are already flaming Microsoft 
because it appears that instead of following strict XML open standards, they 
are making up their own (for a change).  However, I've opened a raw XML 
document into Word, and it opened perfectly, with no problems.  The 
problem, however, may lie in the fact that Word's XML output is not strict, 
standards-compliant XML.  We'll have to wait to see how this all develops, 
but for the moment, it seems fine.  In the end, this may be a problem for 
some people, but for others, this won't have a significant impact.  If you 
know SGML and/or XML, then WP's may have an advantage, but let's face 
it, the average user won't know XML, so Word's has to be the winner in this 
category.  The other huge advantage Word 2003 has over WP11 is that 
when you save as XML, a schema is attached to the Document.  In WP, you 
just get raw tags, which is of no use to anyone except Web Designers or 
people who know XML.  What's so ironic is that WP has had SGML 
capabilities since, at least, version 8!  The really disappointing thing is that 
Corel now owns X-Metal.  So it's a pity WP11's XML isn't as transparent as 
Word's.  We'll probably have to wait for Version 12 to get an XML facility as 
good as Word 11. 

Word & WP: Open Dialog Box WP: 5 

 

 

 

Word: 1 With Office XP, Microsoft FINALLY got a clue and enabled MSOffice Dialog 
Boxes to be resized (previously only a small Dialog Box opened, which 
meant you couldn't see very many files; you, therefore, had to scroll all over 
the place to view your files). 

WP also allows you to perform far better/easier file management capabilities 
from the Open Dialog Box, including, Move, Print File List, etc.  Other 
options such as Undo and Copy are only available in Office 2003 via a right-
click, which may mean many less savvy users miss these capabilities. 

WP still wins when it comes to Previewing a File, as you have the following 
options: 

• Tear Off (Separate Preview Window so you can utilize the entire 
screen, although you don't have to use Tear Off, as the WP 
Preview Window can be resized   . . .  Word's can't.)  

• Page View (Choose which size you prefer in this View: Original 
Size, Size to Width, and Size to Height  

The only notable aspect that Word has is that its Properties are slightly 
better, e.g., you can see the number of words in the document, etc, which 
means you don't have to open the file.  It also has a 'My Places' feature, 
which is basically a Favorites menu, but it's faster to access, so it deserves 
kudos for that. 

Word & WP: Save/Save As WP: 1  WP has far more 'Save As' file types, although, let's face it: in this day and 
age, the choice of file formats is far fewer than it was 10 years ago. 

Word: Save As Web Page  
WP: Publish to HTML 

WP: 1 Word: 5 

 

In Word, it's as easy as saving a standard document.  WP11 has simplified 
(and amplified the power of) its HTML publishing, but Word still wins 
outright, as MS made Web-enabling Word (and MSOffice) its Number 1 
feature/goal. 

WP's Web capability is good, but unfortunately, it doesn't use CSS2 to its 
full extent, which means that graphics lose the ability to be positioned above 
or below text when saved as HTML. 

Word: Permission  Word: 1 This new facility is part of Microsoft's new Information Rights 
Management (IRM) feature, but it requires that your office be using 
Windows Server 2000 SP3 and above. 

The idea is that by assigning Permissions to Files, you can help prevent 
sensitive information from getting into the hands of the wrong people, 
whether by accident or carelessness.  You can give users Read and 
Change access, as well as set expiration dates for content 

This has to be one of the most controversial 'innovations' Microsoft has ever 
introduced.  I've received E-mails from people switching to WordPerfect 



because of this feature!  Others are decrying it as they see it as a way of MS 
taking control of people's content and locking them out of their own 
documents!  It's one of those things that are good in theory.  .  . 

Word: File Search  
WP: Incorporated into the Open   
Dialog Box 

WP: 10 

 

 

 

 

 

 

 Microsoft has once again improved MSOffice's FIND facility, which is good 
news, as XP's was useless.  For example, I copied the text from the Author 
Field of a PowerPoint file's Properties, and then pasted it into a Search 
Dialog box, instructing the Search to Find all PowerPoint Files by said 
Author   . . .  Result?  No files found???  I've tested Word 2003's Find, and it 
does seem better, but it's still not as powerful or as easy to use as WP's 
Find Facility. 

WP on the other hand, has the most powerful indexing and Search facility 
imaginable.  Not only can you setup custom searches, you can save them 
for instant access.  For example, say you often search for a file typed by 
your colleague, you can simply setup a Search, and you can then use this 
saved Search the next time you want to search for a document your 
colleague typed; you don't have to set it up again.  Using WP's Indexer, you 
can also make sure that your Searches are lighting fast, by enabling timed 
indexing of any Folder you want.  Add to this the fact that the WP Search 
Facility is easy to use (and intuitive), and you can see why WP gets 10 
points. 

Word & WP: Properties WP: 1 Word: 1 Both are excellent.  Again, each program has options the other doesn't: 

WP allows you to.  .  . 
Extract META information about a document and save it as a new file.   
Print the Properties (although Word can do this from its Print Dialog Box) 
Delete META Data (Word allows this via Tools » Options) 
Save Properties as a New Document 

Word, however, allows you to.  .  . 
See Statistics about your document, such as the time you've worked on it 
Create new Property Fields 

WP: Signature WP: 1 Word: 1 Both programs allow you to Digitally sign your document. 

WP: Document » Compare  
Word: Compare and Merge 
Documents (Tools Menu) 

WP: 1 Word: 1 Quite similar.  I wouldn't favor one over the other. 

Word: Track Changes  
WP: Document Review 

WP: 1  Both are excellent, although Word users have to be very careful, as you 
MUST check the 'Warn' check box to ensure Word removes tracking 
information before sending files to clients etc, as a known issue in Word is 
that recipients can (embarrassingly) see your Tracked Changes even after 
you remove them (this is why Microsoft specifically added this option in 
WordXP). 

WP & Word » Routing Slip WP: 1 Word: 1 

 

No difference, although Word had this first. 

Word: Default.  .  . 
WP: Document Style 

WP: 5  I really like the way Word has DEFAULT on some of its Dialog Boxes.  
However, and it's a big However, WP does provide a much more 
comprehensive, coordinated approach to setting defaults, & more can be set 
without having to create, delete, & rename the default Template. 

WP & Word: 
Master/Subdocuments 

WP: 1 Word: 1 Both are similar, although Word has literally hidden this ability in the View » 
Outline menu.  Even if you try to look up Subdocuments or Master 
Documents in Help, Word returns no relevant answers.  The only way to 
find out that Word even has this capability is to Search, manually, through 
its Help topics. 

Word & WP: Page Setup   Refer Format Menu 

WP: Subdivide 
Word: Section Breaks 

WP: 5  WP allows you to split your page, e.g., halves, quarters, eighths, etc.  
Particularly useful if you want one page with different margins, boxes, 
columns, etc. 

You can use Section Breaks in Word, but it's nowhere near as easy, 
flexible, or powerful as WP. 

In addition, Word only allows you to insert Section Breaks horizontally—not 
vertically. 

Word & WP: Print  Word: 1 Unfortunately, WP has taken a backwards step, while Word's has gone 
forward.  I always thought the Print Dialog in WP was brilliant, but Corel has 
totally messed with it, and now I find Word's far easier to use and to 



understand. 

Word & WP: Print Preview WP: 5 Word: 1 WP only added this feature in version 9—and only to accommodate people 
switching from Word (and those who didn't realize that WP is in a constant 
state of WYSIWYG [What You See Is What You Get]).  Here's what a 
former employee of Microsoft had to say about Word's WYSIWYG ability.   

"I did support at Microsoft in the Word unit from v1.1a through Word97, 
about four months before the release of Office 2000.  (That's a very long 
time in dog years.)  I can tell you that the reason Word's WYSIWYG is 
sometimes a little shabby was basically performance, and the vagaries of 
the continuous four-way conversation between the printer driver, Windows 
GDI, the font rasterizer, and Word's layout engine.  These four items are 
interdependent and the calculations are intense and performed basically at 
every edit (= every *character* entered or removed; this is why Normal View 
is still around).  Sometimes third-party printer drivers lie about stuff to Word 
or the GDI, or Windows' rasterization of the font outline is faulty, causing 
imprecise WYSIWYG at certain magnifications or display resolutions.  This 
is also assuming a quality font; sometimes the fonts themselves are buggy 
or have crappy kerning tables.  In those days, the answer would have been, 
"Marketing be damned, this isn't desktop publishing, it's a power-user's 
document processor".  The situation has changed fairly dramatically since 
then, in that machines are vastly more capable and can do the calculations 
without an unacceptable degradation of performance: perhaps it's time 
Development looked at Word's WYSIWYG again.  Periodically, whole 
features of Word are gutted and rewritten, as had to be done to enable 
tables-within-tables for Word 2000 when the band-aids and fig-leaves had 
reached the end of usefulness. 
Perhaps the WYSIWYG is next.  One can only hope.  .  ." 

Anyway, so there you have it.  Word still isn't WYSIWYG, and that's why 
Word still has Print Preview, while in WP, Print Preview isn't needed (thanks 
to ingenious programming by the original designers of WP).  However, if you 
do decide to use Print Preview in WP, you still have access to all your 
Toolbars & Property Bars without having to go to View/Toolbars. 

The only good thing about Print Preview in Word is the ability to see all 
pages in your document, which is good for spotting blank pages after a Mail 
Merge. 

WP: Publish to PDF WP: 1  This is integrated into WP.  You would have to either pay for Acrobat, buy a 
cheap PDF-producing program, or put up with a banner-advertisement (free) 
program in order to be able to publish Word documents to PDF. 

This feature has been enhanced in WP11 to support Acrobat 5.0. 

WP: Publish to Edgar WP: 1  New Feature in WP11.  For the legal eagles, here's the info.  from WP's 
Help: 

WordPerfect lets you publish documents to an Electronic Data Gathering, 
Analysis, and Retrieval (EDGAR) system format.  WordPerfect does not 
create all the documentation necessary for a complete electronic filing, but it 
alleviates many problems associated with the ASCII DOS.TXT option.   
WordPerfect EDGAR features include 

· 80 characters per line of text  
· 132 characters per line in tables  
· a restricted ASCII character set  
· an export of footnotes as part of the ASCII document  
· a special tagging for footnote numbering  
· an End Of Document tag 

Word & WP: Send To.  .  . WP: 1 Word: 1 Both have options the other doesn't, e.g., you can send to a Compressed 
Folder or My Documents from WP, but you can send a document for Review 
from Word. 

Word: Recent Documents WP: 1 Word: 1 A great new addition to MSOffice 2000 was the History Folder, which shows 
the last 50 documents used.  I always thought that something like this would 
be a great idea.  However, you can also see at least 40 of your most recent 
Corel documents by using 'New Project'. 

FILE MENU POINTS  WP: 49 Word: 22  

 
Edit Menu Item WP Word Comments 



Word & WP: Find & Replace WP: 1 Word: 1 Both have excellent options, so both get a point. 

Word will find instances of words within a specific situation, whereas 
WP will find the exact coding around it.  Using Word, one can locate 
(eg) the word "Case" if it’s Bold + Italics and within a certain Paragraph 
Style.  Word will find the text under the condition that the _*entire*_ text 
is Boldfaced and Italicized.  Since Word isn’t code-based, coding isn’t 
allowed in the "Find" dialog, although common formatting—eg, "^p" 
(Paragraph Mark)—can be added.  These all work equally for "Find" and 
"Replace" but must be found in the order in which they are typed.  When 
Attributes are added, it is assumed that the _*entire*_ text string 
contains these. 

In WP, when "Finding" the term "Case", to insure it is Bolded and 
Italicized without including the exact Bold and Italics on/off coding, you 
may use the "Fonts" option (Match | Fonts), which, like Word, will find 
instances of when text is Bolded, Italicized, etc.  However, there are no 
similar "conditions" for "Finding" (eg) Center Justification, Paragraph 
Spacing, or other Paragraph Attributes that Word users take for 
granted.  WordPerfect’s "Find" strength is its ability to locate any 
imaginable code, including those that change, such as "[- Soft Hyphen]"; 
"[SRt-SCol]", where a [space] breaks into the next Column, and "[SRt-
SPg]", where a [space] forces a page wrap.  If looking for a specific 
code, including "On" or "Off" codes, this can be a handy macro tool, 
especially for advanced searches in which these codes must be located 
in a certain order.  Which method is preferable is very dependent upon 
how you work and what your specific needs are.  Novice users may 
prefer Word, while Power Users who wish to specify the exact coding 
surrounding text, including the exact order in which these are placed 
(which is inapplicable in Word ), would find WP preferable.  However, 
while WP allows you to search for an Open, Paragraph, or Character 
Style (including the beginning and ending of the latter two), it won’t 
locate such text within a specific Style or merely the specific Style itself. 

Word & WP: Undo/Redo WP: 5  Not only does WP have 200 more Undo Levels, you can save 
Undo/Redo History with your document, i.e., you don't lose the ability to 
UNDO after closing the document or after hitting Save (in WP, this is 
setup by placing a check in the Undo/Redo History Options Dialog).  It is 
*SO* frustrating in Word to hit save and then to realize you've lost any 
chance of Undoing something.  However, both Word and WordPerfect 
could benefit from looking at a program like HomeSite, which Saves 
your Undo/Redo ability *regardless* of whether you hit Save or not (and 
regardless of whether you've checked the Undo/Redo Options box). 

Word & WP: Cut/Copy/Paste   Standard Windows Function. 

Word: Office Clipboard  
WP: Clipbook 

WP: 1 Word: 5 

 

In Word 2000, Microsoft added a Clipboard that allowed you to collect 
up to 12 items to Windows' standard Clipboard.  Corel followed by 
adding a Clipbook to WP10, but MS increased the number of items in 
Word XP to 24 AND added a superb interface—utilizing MSO's new 
Task Pane.  In a way, WP's was better, as its Clipbook size was virtually 
unlimited AND it allowed you to share your clips across a Network.  
However, the Clipboard in MSO had a far superior interface, and it is 
easier to collect and manipulate clips as they are integrated into each 
MSO program.  With Corel's Utility sitting in the System Tray, it's more 
awkward to use, and the interface is nowhere near as good.  Nothing's 
changed in either Word 11 or WP11 (unfortunately), so Word still gets 
the extra points. 

Word: Paste as Hyperlink  Word: 1 Word allows you to Paste as a Hyperlink within your document. 

Word & WP: Paste Special  Word: 5 MS has added Paste as HTML to its 'Paste Special' feature AND it's 
added Paste as Nested Table AND Past Appending Table, which are 
equally clever additions. 

WP: Append WP: 1  Word allows you to append information (referred to as the Spike), but 
once you paste it, the contents of the 'spike' are emptied unless you use 
AutoText, which is pretty convoluted. 

Word: Clear » Formats / / A quick way for Word users to remove Formatting from Text (this would 
be done in WP using Reveal Codes) 

Word: Clear » Contents / / A menu-based way of deleting text.  Silly really, when you've got a 
Delete Key on your Keyboard, i.e., 10 times longer than using your 
keyboard. 

WP: Repeat Next Action  
Word: Repeat Last Action 

WP: 5 Word: 1 You can set WP to Repeat the Next Action anywhere between 2 and 
65,535 times.  Word can only Repeat your last action by continually 
hitting Ctrl+Y (providing you didn't hit Undo, in which case Ctrl+Y 



becomes REDO). 

WP: Convert Case  
Word: Change Case (Format Menu) 

WP: 1  WordPerfect is intelligent about Initial Capitals.  It does not make 
prepositions, conjunctions, or articles capitals (unless it's the first word 
in a sentence). 

Word & WP: Select WP: 10  WordPerfect allows you to Select All, Select Sentence, Select 
Paragraph, or Select Page simply by right-clicking outside your margin 
(you can also select a Section, a Tabular Column, a Rectangle, and a 
Table from the Select Menu).  You can select a word or paragraph in 
Word (and WP) using double or triple clicks, but this isn't as efficient as 
a single 'Right-Click' & Select Action'.  You can easily click too many or 
too few times and select the wrong part. 

In Word, selecting a sentence can be accomplished by holding CTRL, 
then clicking; however, I think it's easier to remember a single action 
(e.g., Right-click outside your Margin) than it is to remember multiple 
combinations for different selections. 

WP: Edit Graphic Box WP: 1  Additional option in WP. 

Available in Word (and WP) by clicking on a Box or by using the 
'Browse By Graphic' option. 

WP: Edit Graphic Line WP: 1 Word: -1 Only available in WP.  This is available in Word by clicking on a Line, 
but I deducted a point from Word as selecting a Graphic Line can be 
very difficult if it's behind another object or text. 

Word & WP: Edit Links  Word: 1 Quite similar, but Word allows you to lock a Link.  It also has options to 
preserve Formatting after updating a Link. 

Word & WP: Edit Object WP: 1 Word: 1 Same 

Word & WP: Go To WP: 1 Word: 1 WP has far more options than Word, but Word has a good feature that 
allows you to jump a certain amount, e.g., +4 will take you forward 4 
jumps instead of clicking 4 times. 

EDIT MENU POINTS  WP: 28 Word: 15  

 
View Menu Item WP Word Comments 
WP: Draft  
Word: Normal View 

WP: 1  Personally, I rarely use Draft/Normal view, so I can't really say which is 
better.  I like being able to see a true representation of my document.  As 
stated in my Version 9 Preamble, when I started using WP, I loved the fact 
that I didn't have to hit Print Preview before every, single document I printed. 

Anyway, were I to use Draft view in WP, something that would've annoyed 
me in prior versions was that WP didn't wrap text when you increased your 
zoom past 100%.  In Version 11, the text now wraps correctly (which 
eliminates a horizontal scroll bar).  WP therefore gets the point instead of 
Word, as Word continues to hide your shapes if you switch from Print 
Layout to Normal view. 

WP: Page  
Word: Print Layout 

  Refer Print Preview on the FILE Menu 

Word: Web Layout  
WP: Preview in Browser 

WP: 1 Word: 5 This is excellent if you use Word to create and edit, for example, Intranet 
pages, as it allows you to use Word as a WYSIWYG Web Editor. 

Word: Reading Layout  Word: 1 A new feature in Word 2003 that.  .  . 

• Hides unnecessary toolbars  
• Displays the Document Map or the new thumbnail pane, so you can 

quickly jump to sections of the document.   
• Automatically scales the contents of a document to pages that fit 

comfortably on your screen and that are easy to browse.   
• Allows you to highlight portions of the document and add comments 

or make changes.   

WP: Two Pages  
Word: Print Preview 

  WP allows you to see 2 pages at once.  For Word, refer to Print Preview 
under the FILE Menu comparison. 

Word: Outline View  Word: 1 Additional Menu Item in Word.  When you create an Outline in WP, your 
Property Bar updates with the necessary features for Outlining.  This allows 
the same functionality as Word's Outline View, i.e., drag-and-drop 
Headings, Text, (or both simultaneously), although you have to select the 
'Show Icons' button to enable this functionality.  I would like this turned on by 
default when you insert an Outline (or better yet, add a Menu Item like this 
one in Word).  The additional Menu Item in Word is also good because it 



automatically assigns all Headings and Text an Outline Level, e.g., 
Headings automatically become Main Levels, etc. 

Word: Thumbnails  Word: 1 An excellent new feature in Word, but this time Word borrows from Adobe's 
Acrobat program!  As you can imagine (or will know if you use Acrobat a lot), 
this feature shows you a thumbnail of all the pages in your document, which 
allows you to jump quickly to a certain page in your document.  Nice. 

Word & WP: Document Map WP: 5 
 

 

 

Word had this first, so here's a case of WP following for a change.  It's a 
new feature in WP11, and it's better than Word's in as far as you can 
choose what to Browse By, e.g., Table of Contents, Table of Authorities, 
Index, or List.  Word's Document Map is Table of Contents only. 

Word & WordPerfect: Toolbars 

WordPerfect only: Property Bars 

WP: 10  This is one area where there isn't even a competition.  Corel realized that 
you don't need all your tools all the time, so it came up with the Property 
Bar. 

The Property Bar sits directly below your Toolbar and updates with all the 
tools you need for the task you're working on.  E.g., Working on a graphic, 
the Property Bar updates with all the tools you need for working with a 
graphic. 

Working on a table, your Property Bar updates for that task; this applies to 
everything: Watermarks, Images, Selected Text, Footnotes/Endnotes, etc.  
You rarely have to turn your Toolbars on & off when you need to work on a 
Task, as you do in Word. 

This is one area where MS could really improve.  I think MS Office's 
Toolbars are ugly and annoying.  By the time you have your Drawing 
Toolbar, your Frames Toolbar (if you're working on your Intranet), your 
Tables Toolbar, your Formatting Toolbar, and your Standard Toolbar on the 
screen, there's hardly any room to see your document!   
Click HERE to see what I mean.  You can shove them together, but then 
you don't see all your Icons <sigh>.  As an IT Consultant and Developer, I 
have been to a LOT of Offices, and I can say that the average user (which is 
the majority) doesn't bother or know how to customize his or her Toolbars, 
so they end up wasting time scrolling up and down a very narrow screen.   
WordPerfect's Property Bar is another productivity feature that makes word 
processing with WP a joy. 

WP: Application Bar WP: 5 

 

 At the same time that Corel introduced the Property Bar (WordPerfect 8), 
Corel also added the Application Bar.  It's slightly thinner than your Task Bar 
(sitting directly above it), and it servers 4 purposes: 

• It shows all your open documents  
• It allows you to drag and drop text between documents  
• It allows you to switch easily between documents  
• It stops you forgetting that you already have a document open  

Word2000 subsequently 'borrowed' the idea.  Every open Office document 
had a separate icon on your Task Bar.  However, this was almost a 
disadvantage, as your Task Bar got really cluttered (you then couldn't see 
what each document was without hovering).  MS realized its mistake, and 
you now have the option of using this facility in MSOXP/2003.  Windows XP 
tiles your documents anyway, so MS's implementation of this is now 
redundant.  Corel's Application Bar still allows the aforementioned features. 

WP & Word: Ruler Bar WP: 5  I personally hate the Ruler Bar (Word turned me off it forever).  Having to 
adjust tabs and indents using the Ruler Bar is onerously time-consuming, 
awkward, and fiddly—especially for a power-user.  Perhaps a little-known 
fact is that it takes literally TEN TIMES LONGER to use a mouse instead of 
a keystroke, e.g., setting an Indent using your Ruler instead of hitting F7 (in 
WP) (refer Format Menu).  Only someone who has used WordPerfect 
would appreciate this.  In Word, you can use keystroke combinations, such 
as Ctrl+M or Ctrl+T, but if you want to move your Tab Stop back, you either 
have to change your Ruler, Edit in the Paragraph dialog Box, or use 
complex keystroke combinations, e.g., Shift+Ctrl+T to move an Indent back!  
Compare these to using F7 or Backspace in WP. 

Nevertheless, if you do like to use your Ruler Bar, WordPerfect allows you 
to Right-click to open the following dialog boxes: Tab Set, Paragraph 
Format, Margins, Columns, & Settings.  Double-clicking on your Ruler in 
Word will open your Page Setup or Tabs dialog Boxes only.  Overall, if you 



wanted to work with your Ruler Bar, it is MUCH easier in WP. 

Additionally and most importantly, because WP flows, if you change a Tab 
stop for one item, each following item changes to the new Tab stop 
automatically (providing uniformity to your document).  In Word, you need to 
highlight all the text to which you want to adjust Tab Stop positions— 
another one of Word's time-wasters.  Basically, using Word often means a 
drop in productivity, as tasks take much longer to accomplish in Word than 
they do in WP. 

WP: Hide Bars  
Word: Full Screen 

WP: 1 Word: 1 Same. 

WP: Guidelines 

Word: Tools » Options »  
Text Boundaries 

WP: 5 Word: 1 WP shows you all your margins, column widths, table guidelines, etc, 
directly on your page.  This allows you to adjust them there & then—and see 
the changes instantly (i.e., in Real Time!).  This is a really big time saver, 
especially for Tables. 

Word can show you boundaries, but you can't manipulate boundaries 
directly (and you have to turn them on and off via Tools/Options/View, 
whereas they're there by default in WP). 

You can use your Ruler in Word to manipulate Margins and Paragraphs, but 
you don't see the effect of the changes until you've finished.  You really 
would not believe how fantastic the RealTime Preview feature is.  When you 
use Word or an older version of WordPerfect, you immediately notice how 
annoying it is having to guess everything. 

WP: Shadow Cursor  
Word: Point & Click 

WP: 1 

 

Word: 1 This was introduced in WordPerfect 8; Word2000 (again) "borrowed" the 
idea.  This allows you to point to any part of a document and start typing.   

WP: Graphics  
Word: Picture Placeholders 

WP: 1  To speed up viewing/scrolling through a document, (and to take the strain 
off your Graphics card—if it doesn't have many MBs of Memory), WP allows 
you to turn off displaying graphics. 

This can be done in Word, but as usual with Word, it's more convoluted 
(you have to go to Tools/Options and put a check in Picture Placeholders.  
To see your graphics again, you have to go back and uncheck the box). 

Word & WP: Table Gridlines WP: 1  In Word, you have to go into Format/Borders & Shading, and then remove a 
Border for this feature to have any affect.  In WP, it works without having to 
remove Borders. 

WP: Hidden Text WP: 1  Word only allows you to see hidden text if you use your Show/Hide option.  
WP allows you to use the Show/Hide option & still not see Hidden Text 
(some people like to work with Show/Hide on all the time—especially in 
Word, where you can accidentally delete a Paragraph Mark). 

Word & WP: Symbols WP: 1  WP has more options for what to display. 

WP: Reveal Codes   Refer Format Menu. 

Word: Task Pane 

WP: PerfectExpert 

WP: 5 

 

 

 Task Panes were a new feature introduced into Office XP; they are 
basically Corel's PerfectExperts (HELP Menu) Microsoft style.   

PerfectExperts are like a context-sensitive Table of Contents on the left side 
of your screen (as opposed to Microsoft Task Pane on the right side of your 
screen).  They guide you through the processes of formatting, creating, and 
changing your documents. 

Introducing Task Panes must have been pretty humiliating for Microsoft, as 
they scoffed at this feature when WP8 was released, instead touting their 
Office Assistants, which they then (humiliatingly) had to demote after a 
massive public backlash against them.  Conversely, people who were asked 
to compare WordPerfect with Word praised the PerfectExperts (I wonder if 
that's why MS introduced them, and I wonder if MS apologized to Corel for 
slating a feature it subsequently 'borrowed' 4 years later).  I see this as yet 
another example of WordPerfect leading and Word following (after many 
years of WP users being more productive).  Just goes to show that Corel is 
years ahead of MS with many features, and Corel often has a better 
understanding of what users *REALLY* want, not what the Software 
Company *THINKS* they want.   

Word& WP: Zoom WP: 1 Word: 1 Word allows you to see any number of pages.  A new feature in WP2002 
was the Magnifying Glass, which lets you Zoom in on a certain section of a 
document. 



Word: Markup  Word: 10 An awesome feature in Word that allows you to view all markup changes in 
your document (or you can limit the kind of change that's displayed.  For 
example, you can use the Show menu to hide formatting changes and 
comments so that you can concentrate on insertions and deletions.  Or, you 
can display comments and changes for a specific reviewer). 

You can also change how Word displays markup by clicking one of the 
'Display for Review' settings on the Reviewing toolbar.  By changing this 
setting, you can preview a document with changes before you accept or 
reject those changes. 

WP has some of these options via Document Review, but it's not as 
powerful as Word's. 

WP: Variables WP: 1  Simply an option to show or hide the Variables that are unique to WP (refer 
Insert Menu) 

Word: HTML Source   This is a ridiculous feature to have.  The amount of extraneous code that 
Word generates is nothing short of phenomenal.  No-one would want to 
view Word's HTML!!!  I really can't understand why this feature was 
included. 

Word: Footnotes  Word: 1 A good feature that lets you hide or show the Footnotes in your document 
(in Web Layout), or if you're in Print Layout, it jumps you to the Footnotes.  
In WP, you have to scroll to see them. 

Word: Headers & Footers  
WP: Refer INSERT Menu 

WP: 5  This is one thing I've never understood in Word.  If you want to Insert a 
Header or Footer in your Document, you have to go to the View Menu?  
Am I the only one who thinks that this is backwards?  How can you view a 
Header or Footer when you haven't created one yet?  This is, logically, on 
WP's Insert Menu. 

Anyway   . . .  comparing the feature. 

 
Well, to achieve "Page 1 of 1" in a Word Footer, you need to know that you 
have to use AutoText, and you have to figure out formatting options.  Also, 
you should note that this is a well known and seemingly permanently-broken 
feature in Word.  As I recall, this has been broken since version 1.0 of 
Word.  Somehow, I don't think Microsoft *can* fix this feature.  The code 
must be too well hidden!? 

Switching to WP.  .  to create a simple Footer "Page 1 of 5" in WordPerfect, 
you simply select Page Number from the Property Bar, type "1", then select 
Total Pages from the Property Bar.  WordPerfect also allows two Headers 
and two Footers.  Word has a convoluted way of doing such. 

VIEW MENU POINTS WP: 50 Word: 23  

 
Insert Menu Item WP Word Comments 
Word: Break   Far out.  I should subtract 10 points from Word for its need to rely on 

Breaks.  We have native Word users in our Office who still don't know how 
to work with Breaks.  This is one of those 'features' that make you want to 
throw your computer out the window when you're working in Word.  If I were 
in charge of Microsoft, with its vast money and resources, I would scrap 
Word and start from scratch *JUST* to be able to get rid of Breaks.  They 
must be the bane of Word users' lives.  Grrrr. 

Word & WP: Page Numbers WP: 5  WP's numbering is easier to use; WP doesn't assume that it's a Header or 
Footer; WP also has many more options, including Volume, & Secondary 
numbering   . . .  oh   . . .  and one other important thing: it works. 

Word & WP: Date & Time WP: 1 Word: 1 Both have advantages.  WP allows you to create your own, whereas Word 
allows you to set the chosen format as your default.  WP allows you to do 
that, but only by adding it to your Current Document Style default. 

Word: AutoText/AutoComplete  
WP: QuickCorrect/QuickWords  
(Refer TOOLS Menu) 

 Word: 1 Word wins this one because it gives you a 'ToolTip' for AutoText entries as 
you begin to type.  WP has the same functions, but you need to remember 
what abbreviations you assigned. 

Word: Fields  Word: 1 I have never used these in Word, so I cannot assess them properly, 
although I believe they are very good.  I have tried to work with them, but I 
find that they are not intuitive and would therefore take in-depth learning (if 
not a course): Now, if they were as easy or intuitive as WP's 'Prompts' 
Feature.  .  . 

Word & WP: Symbol  Word: 1 Word wins due to its Special Characters {although most of these are part of 



WP's QuickCorrect AutoText}.  However, should you wish to, Word also 
allows you to add them (easily) to an AutoCorrect or Shortcut Key AND 
(most importantly) they use Unicode. 

Word & WP: Comments WP: 1  This is so funny: in my Word2000 vs WP2000 comparison, I gave the points 
to Word because I preferred the way they were implemented.  MS then 
overhauled the Comment feature in MSOXP, and since then, Word's 
Comments are like WordPerfect's used to be!  Conversely, Corel improved 
WP's Comments, and made them more like MSO2000 (so WP now gets the 
point)! 

Word: Reference » Footnote 
(or Endnote) 
WP: Footnote/Endnote 

WP: 5  Woh!  WP's Footnote and Endnote feature is FAR more advanced than 
Word's.  You can add Separators, specifying the space above and below 
the separator as well as the formatting, length, and style.  You can also 
increase and decrease numbering.  You can specify what footnotes to keep 
together, as well being able to add a continued message, and you can edit 
the numbering style in the note as well as in the text.  Finally, you can 
specify whether you want to the notes to align with the text! 

Many people still believe that this feature is fundamentally flawed in Word.  
For more information on this subject, click HERE. 

Word: Reference » Captions 
WP: (Tools Menu) 

WP: 5 Word: 1 Word allows you to add a caption to text (it doesn't have to be in a Text or 
Graphic Box).  However, Captions, in general, are far more powerful in WP.  
For example, you can specify the placement of a caption, the rotation, 
whether it's inside or outside the graphic or text box's border, it's absolute or 
percentage offset, its position, and its width!  Phew!  (Note: It has been this 
powerful for 10 years.  Word's still hasn't caught up!?) 

Word: Reference » Cross-
reference 
WP: (Tools Menu) 

 Word: 1 Word deserves the point for this one because its interface is easier 
(although Corel has slightly modified the interface in WP11) 

Word: Reference   . . .   

• Index  
• Table of Contents  
• Table of Figures 

(WP: List)  
• Table of Authorities  

(WP: TOOLS Menu)  

WP: 5  WordPerfect's are more powerful and flexible, although Word has some 
attractive Styles built-in.  Overall, though, I understand that WP's more 
powerful legal features are one of the reasons WP still has a significant 
market share in the legal community. 

As for Table of Contents, I know this is problematic in Word (both from 
personal experience and from reading other's comments) 

Word: Web Component   I've already afforded Word points (twice) for its Web features, so I don't 
think it's fair to keep adding points to a feature that's already been lauded 

Word: Picture 
WP: Graphics 

  Refer Graphics menu comparison. 

Word: Diagram   Refer Graphics menu comparison. 

WP: Shape   Refer Graphics menu comparison 

WP: Chart   Refer Graphics menu comparison 

Word & WP: Text Box WP: 1 Word: 1 Both have excellent options for formatting a Text Box.  Word takes on a 
DTP aspect by allowing you to have a link from one text box to the next, but 
a flaw is that if you add a caption then move the Text Box, the caption 
doesn't move with it???  WP, in total, has more Text Box features, but Word 
definitely deserves a point for being able to link Text Boxes. 

Word & WP: Object WP: 1 Word: 1 Same 

Word & WP: Bookmark WP: 5  WP has more options, the Interface is better, and you can have multiple 
words.  E.g., Say you have a Heading 'General Comments', highlight this in 
WP, choose Bookmark, and WP automatically has 'General Comments' in 
the Bookmark Dialog Box. 

In Word, you have to retype the Bookmark Name into the Dialog Box, and if 
you use a space, Word grays out the 'Add' Button.  A workaround is to 
include an underscore 

WordPerfect also has a 'QuickMark', which lets you choose the point at 
which the cursor will be positioned the next time you open that document; 
this also allows you to jump to that location from the GoTo Dialog at any 
time while working on the document. 

Word & WP: Hyperlink WP: 1 Word: 5 Word improved this feature in MSO2000, and it is still far better (and easier 
to use) than WP's.  For example, Word's History list shows all your recent 
documents, making it very easy to create a link.  It also (easily) allows you to 



use an E-mail Address or a place in the document (Headings, etc), to create 
a new document, to add a screen tip, or to use an Address from IE's 
Address Field! 

WP: Outline, Bullets, and 
Numbering 
Word : Format Menu 

WP: 5  I recently discovered a 12-page document explaining how to use Word's 
Outlining feature.  I think that terms like 'Digging to China', 'The Jason Tab' 
(derived from the unstoppable serial killer of Friday the 13th fame), and 'The 
Rabbit Hole' help to explain what people who use Word's Outlining 'feature' 
have to put up with. 

WP: Variable WP: 1  This was a new feature in WP10.  Variables allow you to mark text that you 
know will change, for example dates, version numbers, or client names.  
WordPerfect allows you to create a variable.  Once you have created a 
variable, you can insert it in a document, edit it, save it, or delete it.  
Enhancements to the variables feature in WP11 make it easier to store, 
retrieve, and reuse documents. 

WP: Watermark  
Word: Format » Background » 
Printed Watermark 

WP: 1 

 

 

 

 

 This was a new feature in WordXP, but WP has had this since at least 
1993!!!  All I can say to MS is   . . .  about time!  You used to be able to add 
a Watermark in Word, but it was very convoluted.  WordXP was the 1st 
version to enable the insertion of a Watermark easily. 

Anyway, WP still wins this section because you can easily have 2 
Watermarks (A & B), and you have TOTAL control over all the details of your 
Watermark.  With Word, you have very few options as to what you can do 
with it. 

WP: Line WP: 5  WP has 3 options that are very easy to use: Horizontal, Vertical, and 
Custom lines. 
You can add lines in Word via either the Drawing Toolbar or the Borders & 
Shading Dialog Box (???), but they can be nightmarish to edit if they are 
behind text (as opposed to WP, where they're easy to 'grab' using Reveal 
Codes). 

Word & WP: Equation WP: 1  WP has two Equation Editors: The Versions 5.1 - 8 and a newer one.  The 
newer version is almost the same editor that's used in Word (a scaled-down 
version of a program called MathType.  The disadvantage to the newer 
Equation Editor is that all of your equations are done in Times New Roman 
regardless of what your base font is.  In the older WP Equation Editor, if you 
chose a default font, then all the equations are created in the default font, 
but you can also change the entire equation to a different font, color, or size.  
This is not true with the newer Editor.  The newer version is a point-and-click 
Equation Editor (e.g., you have to click on a button with groups of related 
symbols to get any formatting, such as fractions or special symbols).  There 
are a few shortcut macros (like ctrl-H for exponents) for common formatting.  
With the old WP Equation Editor, there is a steeper learning curve, but once 
you've learned it, you can do all the work from the keyboard without having 
to move back and forth to the mouse. 

Word & WP: Sound WP: 1  Easier to insert into a WP document, as it doesn't have to be done via the 
Object Dialog box. 

Word & WP:  
Spreadsheet/Database 

WP: 1 Word: 1 Both have many ways of inserting—and linking documents to—a database 
or spreadsheet. 

WP: Insert » Other » Filename 
Word: via AutoText 

WP: 1 Word: 1 Same, although, in Word, it's hidden in AutoText. 

WP: Insert » Other »  
Path & Filename 
Word: via AutoText 

WP: 1 Word: 1 As above. 

WP: Counter WP: 1  If Word has this feature, I can't find it. 

Word & WP: Bar Code WP: 1  Unbelievably easy in WP, but not so in Word. 

WP: Insert » File WP: 1 Word: 1 Same, but Word allows you to insert the File as a link   . . .  but that's just 
basically a Hyperlink. 

INSERT MENU POINTS WP: 50 Word: 17  

 
Format Menu Item WP Word Comments 
Word & WP: Font WP: 1  If you use the Font Dialog Box, both give you a preview of a highlighted 

word.  However, with WP's amazing RealTime Preview, you rarely have to 
open the Dialog Box or hit UNDO.  WP also allows you to edit Font 
Mapping, and you can set the shading for Fonts.  Word's only unique 
ability is 'Text Effects', but I can only ever recall seeing this used once by 
anyone, as it can make the text hard to read and can be distracting.  This 



might be fun for kids, but I don't think it has a use in the business world. 

WP: Line » Tab Set  
Word: Tabs 

WP: 5 Word: 1 WP is more comprehensive, and the interface is far more intuitive, as you 
have the option to set your Tabs from the left of the paper or from the left 
of the margin.  Another superb feature, which is so simple and logical that 
I can't believe it's not in Word, is the ability to 'Repeat' your Tab Stops at 
specified intervals.  In Word, you have to set each and every single Tab 
Stop (if you are setting up your own). 

Additionally, because of WP's 'Stream Formatting', Tabs are a breeze.  
There's no highlighting of text/paragraphs required.  Want to change a 
Tab Stop?  Simply amend it at the point you're at, and WP alters all the 
following Paragraphs according to the new Tab Stop, providing uniformity 
to your document—simplicity itself. 

Word does get a point, though, because I like its Interface for setting 
Leader characters, although you are bound to a certain Leader character; 
in WP, you can choose your own! 

WP: Line-Height WP: 1  Line Height only exists in WP.  In Word, you would have to "work" with 
Word's Paragraph Formatting to simulate WP's Line-Height ability. 

WP: Line-Spacing  
Word: Paragraph » Line Spacing 

WP: 10 

 

 

 

 

 Word, in trying to be everything, has made Line Spacing far too complex 
for a word processor.  It has the following options:  

• Single  
• 1.5 Lines  
• Double  
• At Least  
• Exactly  
• Multiple  

If you use Word for Desktop Publishing, these are great options, but let's 
face it, if your company is a publishing house, or has a publishing 
department, surely it is going to want to use a proper Desktop Publisher 
like Ventura or MS Publisher—why use a word processor?  It is far too 
confusing and unnecessary having these options in Word, and as I said in 
my Preamble, it's confusing for a new user.  E.g., did you know that 
Word's single line spacing is actually not single line spacing?  It's single + 
some, e.g., 12pt is actually 14.4.  Only 'Exactly' gives you 12pts for a 12pt 
Font (???) 

WP's Line Spacing is as easy as follows:  

• To increase, select 1, 1.1, 1.2, etc  
• To decrease, select.9, .8, .7, etc  

WordXP—for the 1st time—added Line Spacing to its Standard Toolbar 
(as has been the case in WP since I first used it); in my mind, this is a 
concession, i.e., MS realized that Line Spacing is too complicated in 
Word, so it's trying to get users familiar with the Toolbar icon instead of 
having to understand the Line Spacing feature in the Paragraph Dialog. 

WP: Line » Numbering  
Word: Page Setup » Layout » 
Line Numbers 

WP: 10  Far, far more advanced in WP.   
Word does not have the following: 

• Numbering Method (e.g., 1,2,3; a, b, c; i, ii, iii)  
• First Printed Line Number  
• Position from Margin or Page (it only has position from text)  
• Count Blank Lines (yes/no)  
• Number all Newspaper Columns  
• Font Formatting for your Numbers  

WP: Line » Center WP: 1  In WP, press Shift+ F7 

This is how you accomplish the same in Word:  

Method 1: 

1. Align your Paragraph as centered to figure out the exact center of 
your document  



2. Double-click your Ruler at this point to insert a Center Tab Stop  
3. Change your Paragraph Alignment back to Justified or Left-

Aligned  
4. Insert a Tab  

Method 2: 

1. Figure out the exact center of your document  
2. Double-click your Ruler to insert a Center Tab Stop  
3. Insert a Tab  

'Nuff said. 

WP: Line » Flush Right WP: 1  In WP, press ALT+F7 

Word XP made this easier, but here's what you still have to do to in Word 
to Flush Right 

1. Type your text  
2. Use your mouse to position your I-Beam to the right of the line 

you need Flushed Right  
3. Double-click to insert a Right-Aligned Tab Stop  
4. Use the Home key (or your Mouse) to go back to the beginning of 

the line  
5. Insert a Tab  

WP: Line » Flush Right w/ 
Dot Leaders 

WP: 1  In WP, press ALT+F7+F7 

As above, Word XP made this easier, but here's what you still have to do 
to in Word to Flush Right with Dot Leaders 

1. Type your text  
2. Use your mouse to position your I-Beam to the right of the line 

you need Flushed Right  
3. Double-click to insert a Right-Aligned Tab Stop  
4. Double-click the Tab Stop  
5. Select a Leader character and click OK  
6. Use the Home key (or your Mouse) to go back to the beginning of 

the line  
7. Insert a Tab  

Word: Paragraph 
WP: Paragraph » Format 

WP: 1 Word: 1 Much simpler in WP.  Word's is too complex, probably because 'Line' 
doesn't exist in Word.  Everything is treated as a paragraph.  However, 
one Word feature that I know many people like is the ability to specify 
different spacing both before and after a Paragraph.  In WP, spacing is an 
individual setting, using 'number of lines' or 'distance in points'. 

Word & WP: Paragraph » 
DropCap 

WP: 5  The options available in WP make Word's Drop Cap look like Word 
version 1.0 instead of Word 2003.  There are so many things you can do 
with Drop Caps in WordPerfect that it would take a page to list them all!  
Another great feature (added in WP10) is the interaction of Drop Caps 
with the RealTime Preview, giving WP an even bigger advantage over 
Word. 

WP: Paragraph » Border/Fill WP: 5  Far superior in WP as it has the following options that Word doesn't:  

• Shadow (Height, Width, Depth, and color)  
• Spacing  
• Gradient (with vertical and horizontal offset + rotation angle)  
• Fill (Styles, Gradient, Foreground, Background, and Pattern)  

Word & WP: Paragraph » Indent WP: 10  * SO EASY * in WP.  Simply hit F7 to have all text flow according to the 
indent.  Hit Return to break the Indent.  10 Points for this feature may 
seem over-the-top, but it is something I use all day, every day—especially 
in Tables. 

Achieving the same result in Word is Convoluted.  You have to hit Ctrl+T 
AND THEN TAB to the indent, (or you can mess around with the Ruler, 
which is a real time-waster).  To clear this, you have to hit Shift+Ctrl+T.  
Of course, you can use your Ruler, but, again, it takes (literally) 10 times 



longer than using keystrokes. 

If you use the Indent Icon, your whole line indents (Word's Ctrl+M 
equivalent), instead of the text you want to wrap.  Word has an 
AutoCorrect Option that's supposed to set Indents using the Tab Key.  
However, this is restricted to the beginning of a line, i.e., you can't type 
text, hit Indent, and then have the rest of the text indent FROM THAT 
POINT (Ctrl+T).  Also, it's a First Line Indent, not a full indent.  *sigh* 

WP: First-Line Indent WP: 1 Word: 1 Same.  Type your text, and then return to the beginning of the first line to 
create a first-line Indent. 

WP: Paragraph » Hanging Indent WP: 1 Word: 1 In WP, use Ctrl+F7.  In Word, use Ctrl+T 

WP: Paragraph » Double Indent WP: 1  (Note: This is often used for Quotes) 

In WP, click Ctrl+Shift+F7  
In Word, again, you need to use your Ruler or the Paragraph Dialog Box. 

WP: Paragraph » Back Tab WP: 1  WP only.  You achieve this in Word by using your Ruler Bar or Paragraph 
Dialog.  It's also not broken by hitting Return—back to the Ruler or 
Paragraph Dialog for Word users. 

Word & WP: Columns WP: 10  WP Word 

Maximum Number of Columns 

• 24  • 14  

Types: 

• Newspaper  
• Balanced  
• Newspaper  
• Parallel  
• Parallel  

w/Block 
Protect  

• Use Text Boxes to create some of 
WP's options  

Options 

• Border  
• Shadow  
• Advanced  
• Fill  

• Line Between  
• (Use Borders/Fill Dialog to recreate 

some of WP's options)  

 
WP & Word: Page Setup WP: 1 Word: 1 Both are very good.  WP's interface has changed slightly, making it easier 

to select a Paper Source, but I love that Word has this on its 'Paper' Tab.  
I also like how easy it is to understand Mirror Margins in Word.  In WP, I 
like how easy it is to understand binding. 

Word & WP: Page » Center WP: 1 Word: 1 Same 

WP: Page » Suppress WP: 1  Available only in WP to suppress Headers, Footers, Watermarks, etc. 

WP: Page » Delay Codes WP: 1  Available (only in WP) to Delay features such as Line Numbering, Images, 
Page Setup, Headers/Footers, Fonts, Watermarks, etc. 

WP: Page » Force Page  
Word: Break-Even/Odd 

WP: 1 Word: 1 Same. 

Word & WP: Page-Border Fill   Refer Paragraph Border/Fill 

Word & WP: Justification WP: 1  WordXP followed WP's Full justification, as Word's Full Justification used 
to be 'ALL'.  However, now you have to hold Shift when you hit Return if 
you want to create 'All' justification in Word.   

A great feature in WP is the fact that your Toolbar is less cluttered, as WP 
has only one drop-down icon.  Additionally, using WP's RealTime preview, 
you always get a chance to see how the document (or highlighted text) will 
look with different justification before changing it (then having to Undo it). 

Word & WP: Margins WP: 5  WP allows you to adjust Margins directly on your page (for any part of 
your document, not just the whole page—as you would if you were using 
Word's ruler.)  You also see the changes instantly with WP's RealTime 
Preview—no guessing.  I also love that WP has a Minimum or Even option 
for its Margins, making it easy to achieve such.  One thing I *hated* in my 
days of using Word was setting a margin only to receive that annoying 



message from Word that the setting was outside the printable area.  Why 
did it allow me to set a margin that can't print?  WP won't allow you to do 
this, which I love.  There's only one thing that's *worse* in this version of 
WP: Margins now reduce by a 10th of a centimeter instead of by ½ a 
centimeter, i.e., instead of going 2.5, 2.0, 1.5, it now goes down from 2.54 
to 2.44, etc.  Thanks Corel.  Grrrr. 

WP: Make It Fit WP: 10  WP can shrink (or expand) ANY size document to the specific number of 
pages, giving YOU the option of what to reduce, e.g., Font, Spacing, 
Margins, etc.  Additionally, only WP gives you the option of 
'Block Make It Fit', which lets you adjust a specific number of pages within 
your document.  Word (on the other hand) can reduce your document by 
just one page, and you have no say in what it will change to make it fit. 

Word & WP: Widow/Orphan WP: 1 Word: 1 No difference 

Word: Keep Lines Together  
WP: Block Protect 

WP: 1 Word: 1 No difference 

WP: Conditional End-of-Page WP: 1  You can specify exactly how many lines will stay with, for example, a 
Heading. 

Word: Page Break Before  Word: 1 An option to ensure that there's always a Page Break before a particular 
paragraph. 

Word: Keep with Next   Errr, an option that forces a paragraph to stay with the next one, but this is 
the same as Block Protect??? 

WP: Typesetting » Advance WP: 1  Can only be done in Word using Field Codes or Spacing Before/After. 

WP: Typesetting » Overstrike WP: 1  Used to create custom symbols by superimposing two or more characters 
or symbols to create one character or symbol.   
E.g., combine the number 7 with a hyphen to create a European 7 
character;  
Combine characters to create mathematical symbols, language symbols, 
and other character combinations.  You can also edit a custom symbol. 

Not available in Word 

WP: Typesetting »  
Printer Command  
Word: {Field Codes} 

WP: 1 Word: 1  

WP: Typesetting »  
Word/Letter Spacing 

Word: (Font Dialog) »  
Character Spacing 

WP: 1  It's per character only in Word.  In WP, you can set spacing for a whole 
word, and it doesn't adjust each character. 

WP: Typesetting » Kerning WP: 1  More powerful and much easier to accomplish in WP.  Also, Word does 
not support word spacing justification limits, or manual kerning 

Word & WP: Envelopes WP: 5  Much easier & far better in WP.  Word has a one-at-a-time interface, 
which is ridiculous.  In WP, it's just type away until you're ready to go. 

Word & WP: Labels WP: 10  WordPerfect has always had an advantage over Word when it comes to 
Labels, as you can insert Headers (and Footers), which allows you to add 
a logo to a Header and then have that logo on every label.  In Word, you 
would have to add a logo to every label manually, one by one.  By the 
way, this is a feature that our organization uses all the time, as we have 
(different) logos on our Labels and Name Tags (depending on who's 
sponsoring an event or which campaign is running an event). 

Another advantage is WordPerfect's RealTime Preview, meaning that 
you can adjust any single label on-screen by, for example, changing the 
Font Size, dragging a margin, etc.  and see the changes in Real-Time 

WP: QuickFormat  
Word: Format Painter 

WP: 5  WordPerfect allows you to select WHAT you want to copy, i.e., 
Characters, Headings, Table Cells, Table Structure, etc.  However, the 
real advantage over Word's Format Painter is that there aren't 2 options 
when you want to use this feature.  You turn it on, and it stays on until you 
turn it off.  In Word, when you click the Format Painter, it turns itself off 
after a single application.  To keep the Format Painter on until you turn it 
off, you have to double-click it, which I find annoying, and obtuse. 

WP: Graphics Style WP: 1  Not available in Word. 
WP allows you to create your own Graphics Styles for Boxes, Borders, 
Lines, Fill, etc. 

WP: Styles 
Word: Styles and Formatting 

WP: 1 Word: 1 Major overhaul time for Word.  One of MS's main 'features' in OfficeXP 
was making the program easier to work with.  In doing so, a new interface 
was introduced for working with Word's Styles.  It's well done, and MS 
gets kudos for adding 'Clear Formatting', as this was a MAJOR bugbear in 



Word (i.e., its complicated and unasked-for formatting).  Now, you can 
clear all formatting from an area and start from scratch.  Definitely a 
welcome addition to Word—pity it took 10 versions for MS to realize that 
many people HATE a program thinking for them and making changes that 
they don't ask to be made! 

WP's Styles are excellent though, and many people think they are more 
powerful and easier to work with than Word's. 

Word: Text Direction  
(WP: via Table Property Bar) 

WP: 1  Only WordPerfect can rotate your Text 180 degrees 

Change Case   (Refer EDIT Menu) 

Word: AutoFormat  Word: 1 Only available in Word.  A good feature for beginners, who aren't familiar 
with ways of formatting documents.  Also good for cleaning up E-mails 
when using Word as your E-mail Editor in Outlook. 

Word: Background  Word: 1 Word has this on its Format Menu all the time, even though it's meant for 
Web Pages, which is confusing because Word lets you choose options 
that can't Print.  Fortunately, it does disallow Watermarks when in Web 
Page Layout, but it does not disallow 'Background' when in Print Layout. 

Word: Themes  Word: 5 Added to Word2000 for HTML documents—it would be even better if you 
could customize the Themes!  Nevertheless, they are great for providing 
uniformity to your Intranet documents. 

WP: Reveal Codes  
Word: Reveal Formatting 

WP: 10 

 

 

 

 

Word: 1 What can one say?  Victory is sweet.  After a decade of Microsoft insisting 
that Reveal Codes was antiquated and unnecessary, MS *FINALLY* 
conceded and attempted to implement a similar feature into WordXP.  
The interface is good yet overly complicated.  In WP, you don't HAVE to 
compare sections, as the Codes are right there in front of your eyes; to 
attempt to do the same in Word, you have view up to 4 different sections 
of unnecessary information, broken down into Font, Paragraph, Section, 
Headers and Footers, etc, etc.  The term 'Information Overload' springs to 
mind.  Nice try MS   . . .  and congratulations on eating humble pie by 
finally conceding that the feature you laughed at (Reveal Codes) is 
actually a necessary part of everyday word processing. 

Word: Frames  Word: 5 Again, an excellent interface for creating Intranet Pages. 

Word: Text Box WP: 1 Word: 1 No difference.  Simply click on an object in WP to have the Property Bar 
update with Graphics options. 

FORMAT MENU POINTS  WP: 128 Word: 26  

 
TABLES 

Before I start my rant, you need to know that WordPerfect's Tables are *FAR* more powerful than Word's are.  However, EVEN if 
Word's were more powerful than WordPerfect's, I still wouldn't use Word's Table feature. 

I therefore don't think there is any point in comparing Word's Tables with WordPerfect Tables.  Why?  Because Word's Table feature 
is *so* bad (read: temperamental, frustrating) that it doesn't matter how many features Microsoft adds, it can never compare to 
WordPerfect's Tables.   

Please understand that the issue here is nothing to do with which word processor has more features, how those features are 
implemented (e.g., User Interface), or how easy it is to select, delete, or edit the Tables—the issue is that Word's Tables are 
*SO FRUSTRATING!*    . . .  Rows can have different-sized cells; spacing and alignment can be a nightmare; row 'features' are weird 
(e.g., illogical height), etc., etc., etc.   

I would honestly use WordPerfect 6.1 (the first version I ever used), than the latest-and-greatest version of Word.  I know of several 
people who have bought WordPerfect *JUST* so they don't have to work with Tables in Word.   
I think that says it all. 

For an example of what I'm talking about, click HERE to see a screen shot of a table 'acting up' in Word.  Trying to fix these kinds of 
weird problems is a genuine hindrance to productivity. 
 
Tools Menu Item WP Word Comments 
Word & WP: Spell Checker WP: 1 

 

Word: 1 Same, although WordPerfect was the first program to be able to 
separate 2 joined words.  This was new in Word XP 

Word & WP: Grammar WP: 10  WP wins this by a LANDSLIDE.  For Formal Checking, Word 
has 32 options you can turn on or off, compared with 67 in WP. 



WP gives you a definition of each rule.  Word does not.  
Therefore, unless your grammar is excellent (can you remember 
what a Restrictive Relative Pronoun is?) you're left foundering.  
WP would tell you what this is & give you extensive examples.   
 
WP also lets you see a Parse Tree, Parts of Speech, Basic 
Counts, & Flagged Items-Word offers none of these.  WP's 
'Readability' is also far more advanced. 

Word & WP: Thesaurus WP: 5 

 

Word: 1 WP has always excelled with its Thesaurus features.  In Version 
8, Corel introduced 'Prompt-As-You-Go': every word you type is 
instantly accessible from a drop-down Combo-Box.  Word added 
a faster way to access its Thesaurus in Word2000 via a right-
click action. 

WP is still ahead of Word, as looking up a word in WP gives you 
the following: 

• "Related Words"  
• "Is a Type of"  
• "Has Types"  

    

WP: Dictionary WP: 1 

 

 Word has finally added a Dictionary (incorporated into its new 
'Look Up/Research' Task Pane), which is about time.  Of course, 
you have to be online to use this facility. 

    

Word: Research  Word: 1 Basically a quick way to Research items, using Encarta, a 
Dictionary, etc.  Most reviews of this feature are quite similar: It's 
OK, but no great shakes.  Most people would rather use Google 
to Research instead of MSN, etc.  Again, you need to be online 
to use the feature. 

WP: QuickCorrect  
Word: AutoCorrect Options 

WP: 5  OK, I have a couple of major annoyances with Word's 
AutoCorrect (or lack thereof): 

En-Dashes (e.g., 1:00–2:00p.m.): Word only has 1 option for 
converting hyphens into dashes.  Therefore, if you type the time 
using 2 hyphens, Word transforms your hyphens into an Em-
Dash instead of an En-Dash.  In WP, you have 3 options: 1 
Hyphen remains a hyphen.  2 Hyphens become an En-Dash; 3 
Hyphens become an Em-Dash. 

End-of-Sentence Spacing: WordPerfect automatically changes 
one space to two between sentences.  Word has no option for 
changing end-of-sentence spacing, which is SO stupid because 
it has the grammar option to check for 'Spaces Required 
Between Sentences'.  Set this to 2, and Word flags EVERY, 
single, solitary sentence as a grammatical error.  Grrr.  So, if you 
use Word as your word processor, you have to 3 'workarounds': 

1. Type 2 spaces after every, single sentence in every, 
single document you create  

2. Perform a Find & Replace to replace every period and a 
space with a period and 2 spaces in every, single 
document you create  

3. Click 'Change' for every, single occurrence that Word 
flags when you run a Grammar Check in every, single 
document you create  

WP: SpeedLinks WP: 1  WP only.  Type a word like Corel, and a Hyperlink is 
automatically created from your predefined SpeedLinks.  You 
can achieve the same in Word, though, using AutoText. 

Word: Translate  Word: 5 Word only.  Performs translations using the new Research Task 
Pane, although it specifies that the translations cannot be 
guaranteed. 

Word & WP: Hyphenation WP: 1 Word: 1 WP allows you to define the Left & Right Hyphenation Zones.   
Word gives you the option of not hyphenating words in CAPS, 



which is clever, it also allows for prompting before hyphenation. 

WP: Character Mapping WP: 1  Available in WP to reduce a document's size when you edit 
documents in non-Roman alphabets such as Greek or Cyrillic. 

Word & WP: Macros WP: 5  Both are very good, but I gave WP 5 points because you can use 
Macros without fearing that they might contain a Macro Virus.  
Word added security as part of Microsoft's new security initiative.  
What did it do?  Did it split Macros from documents or files so 
that you open or send documents without worrying that they 
contain viruses?  No.  It turned the feature off by default!  What a 
joke!  So MS is basically saying, in order to make Word secure, 
you're better not to use Macros!?!?!? 

WP: Address Book WP: 1  Only available in WP.  Available in Word when creating 
Envelopes & Labels. 

Word: Letter & Mailings » Mail Merge  
WP: Merge 

WP: 1 Word: 1 In XP, Word totally revamped its Mail Merge feature to include a 
Wizard (incorporated into its Task Pane).  I thought that it was a 
big improvement, but today, I watched TWO people (both trained 
in Word) struggle to perform a Merge with this feature.  In the 
end, they had to call me over to show them how to use it!  The 
Data File was an Excel File that they had been E-mailed, so both 
figured they needed to use Word to do the Merge.  When I 
explained to them that they could use WordPerfect and showed 
them how to do the merge using WordPerfect, they were 
amazed by the simplicity of it! 

Back to Word, however, we were all bewildered by the way that 
Word only shows 1 sheet of your Labels.  You have to click 
through each Label or use a Find to preview all your Labels 
(Print Preview does not show you them all?!) 

Word & WP: Sort WP: 10  WP has an amazing capability when it comes to sorting.  You 
can easily create your own custom sorts, choose where to output 
the sort (e.g., a new document), or even sort by the last word, 
etc.  The list is endless, and no comparison can be made 
between the two programs. 

Word & WP: Highlight WP: 1  WP has more colors from which to choose. 

Word & WP: Hyperlink   Refer 'Insert' Menu 

Word & WP: Bookmark   Refer 'Insert' Menu 

Word & WP: Word Count WP: 1  Three U.S.  Court-of-Appellate Judges admonished Word for 
giving erroneous word counts.  WordXP addressed this issue, by 
not 'graying-out' the 'Include Footnotes and Endnotes' checkbox 
when text is selected.  It has also added a special Word-Count 
Toolbar, which is a nice feature.  WP is still better though, as it 
has the following options that Word doesn't: 

• Sentences  
• Average Word Length  
• Average Words per Sentence  
• Maximum words per Sentence  

Some of these options are available through Word's 'Readability 
Statistics', but these also pale by comparison to WP's Readability 
Statistics, which have been awesome since version 6.1 (at least). 

WP: Legal Tools: 

• Pleading Paper  
• Pleading Expert Designer  
• Pleading Expert Filler  

Word: New » Templates » Pleading Wizard 

WP: 1  I'm not a lawyer, so I can't honestly say which is better, but I do 
know that WP still has a strong Legal Following, which I believe 
signifies Word's Legal inadequacies 

Word: AutoSummarize  Word: 1 Only available in Word.  However, I honestly can't see anyone 
trusting this to pick out key points in a document. 

Word: Shared Workspace  Word: 1 A document workspace is a Web site with features that enable a 
group to share files, participate in discussions, and work together 
on a document.  Document workspaces are based on Microsoft 
Windows SharePoint Services. 
Your Office document is stored in a document library in the 
document workspace, where everyone who is working on the 
document can access it—using either a Microsoft Office 



application or a Web browser. 

There's the spiel on what it is.  Hmmm.  The cynical side of me 
says that this is just a way for MS to sell you another of its 
products.  You can decide for yourself whether you think this is a 
good feature or a marketing ploy. 

Word: Track Changes   Refer FILE Menu 

Word: Protect Document WP: 1 Word: 10 Microsoft has made an already excellent idea even better in 
Word 11.  This feature allowed people see a document but not 
change it; however, in Word 11, this feature has been fine-tuned 
to allow you to control document formatting, content, or both.  
Not only that, you no longer have to apply the same restriction to 
everyone and to the entire document.  You can selectively allow 
certain people to edit specified parts of the document.   

The interface has also been revamped, as it's now incorporated 
into the Task Pane and includes (basically) a Wizard, which 
makes it even easier to work with this feature. 

The only way to duplicate this feature in WP is to create a Table 
with locked cells. 

Word: Letter Wizard  
WP: PerfectExpert 

WP: 1 Word: 1 Both are excellent when helping users set-up a letter. 

Word: Compare and Merge Documents 
WP: File Menu » Document » Compare 

   Refer FILE Menu Comparison 

Word: Online Collaboration  Word: 1 Only available in Word.  I don't know why it's in Word as well as 
Outlook, (unless you're going to collaborate on a document 
online).  Seems a bit of overkill if you use a Shared Workspace, 
though? 

Word: Templates and Add-Ins  
WP: Settings » Customize 

WP: 1 Word: 1 Both have good interfaces for manipulating Template and 
Toolbar information. 

Word: Customize 
WP: Settings » Customize 

WP: 1 Word: 1 Same. 

WP: Settings  
Word: Options 

WP: 1 Word: 1 Both have excellent, extremely-extensive Options (which would 
take another Menu to outline in detail!). 

TOOLS MENU POINTS WP: 50 Word: 27  

 
Window Menu Item WP Word Comments 
Word: New Window   Word: 1 Word only.  This allows you to open the same document in a new window 

(so you can compare different sections of a document).  It's a clever idea, 
which would involve opening the same document as a copy in WP. 

WP: Cascade WP: 1   WP only.  This allows you to cascade your Windows, one on top of the 
other. 

Word: Compare Side-By-Side  Word: 5 Very clever idea to allow you to compare 2 documents you think may be 
similar.  Of course you could do something similar in WP, but the clever 
part comes as Word performs synchronous scrolling, i.e., both documents 
scroll simultaneously! 

Word: Split  Word: 1 Similar to 'New Window', except instead of two copies of the same 
document used to compare different sections of the same document, this 
allows you to 'split' (visually only, not actually) the same document into 
sections to compare, etc.  Again, a very clever idea. 

WP & Word: Previous/Next 
Window 

WP: 1 Word: 1 Exactly the Same (Ctrl+F6 & Ctrl+Shift+F6).  Word has just added this to 
its Toolbar, which of course could be done by a WP user. 

WP: Tile Top to Bottom 
Word:  Arrange All 

WP: 1 Word: 1 Arranges your Windows neatly, one on top of the other. 

WP: Tile Side by Side WP: 1  WP only.  Arranges your Windows neatly, side by side. 

POINTS WP: 4 Word: 9   
 
Help Menu Item WP Word Comments 
WP: Help Topics » Contents  
Word: Help: Microsoft Word Help » Table of Contents 

WP: 1 Word: 1 Same. 

WP and Word: Index WP: 1  This seems to have disappeared from MS Office. 

WP: Find 
Word: Show the Office Assistant 

WP: 5  Both are natural language, and both WP & Word return a 
possible list of answers from which to choose.  Both don't 



always return a topic you were looking for, but I find that 
WP has the edge for returning an answer closest to that 
which you asked.  WP also gives you two sorts of help: 

• An overview of the topic  
• A 'How to.  .  .'  

WP also lists 'Related Topics'  
WP also has 'OPTIONS' for any order, exact order, at 
least one of the words, show words that begin with the 
character you type, etc, etc, etc. 

WP: Corel Knowledge Base WP: 1  Just a quick way to go to Corel's Website. 

WP: Macro Commands WP: 1  Newly added to the Help Menu; this lists all the 
PerfectScript commands and provides a quick way to 
search for Help regarding them. 

WP: CorelTUTOR  
Word: Office on Microsoft.com 

WP: 1  These are quite similar, but I've given WP the point 
because you don't have to be online to view the Tutorials, 
and you don't have to find them at the Office Website.  
(HINT: They're currently on the Left Navigation Pane). 

WP: Perfect Expert   Refer View Menu . . . 

WP: Corel on the Web:  
Word: Office on Microsoft.com 

WP: 1 Word: 1 Just a way to go to Corel's and Microsoft's Websites 
(Office specific). 

Word: Detect and Repair  Word: 1 

 

Both programs use Windows Installer technology to 
Detect and Repair the program, although this option 
provides a quick way to access this feature. 

HELP MENU POINTS WP: 11 Word: 3  
 
Graphics Menu Item WP Word Comments 
It's not worth comparing like-for-like with regard to graphics (you'd be scrolling down this page forever, and there'd be no point!).  I 
have only noted and compared features that are either better or nonexistent in one or the other program). 

Word: Colors & Lines » Fill » Transparency  Word: 1 Word allows you to set the opacity of a fill. 

Word: Colors & Lines » Line WP: 1  In Word, you have to edit clip art in order to add lines to it. 

Word: Colors & Lines » Arrows 
WP: Properties » Line 

WP: 1  WP has far more arrow 'Begin' and 'End' Styles 

Word & WP: Size WP: 1  WP has a 'Full' Option that will force lines to fill the text area. 

Word: Rotation  
WP: Rotate Shape 

 Word: 1 Word allows you to specify any angle.  WP is freehand only. 

WP: Move WP: 1  WP allows you to move images freely within their placeholders. 

Word: Layout  
WP: Wrap 

 Word: 1 Word has more wrap options. 

Word: Picture » Crop  
WP: via OLE 

 Word: 1 I gave Word the point because you don't require OLE to crop a 
picture. 

Word: Image Control  
WP: Image Tools 

WP: 5  This is (sadly) one of the few areas where WP leaves Word's 
graphics behind.  The control you have over an image is truly 
excellent. 

Word: Web  
WP: HTML Properties 

WP: 1  OK, by now you'll have read how fantastic Word's HTML & XML 
capabilities are, so it's a surprise that WP surpasses Word on 
this one!  Word only allows you to add an ALT Tag to your 
Image, whereas WP allows you to do this and to choose which 
format you would like your image output (jpg or gif).  WP also 
allows you to assign a URL, a Bookmark, and a Target Frame to 
your Image—although you can easily add a Hyperlink to a Word 
image via the right-click menu (or Ctrl+K). 

Word& WP: Line  Word: 5 Far greater in Word, as you can hold your Shift key to constrain 
a line or your Alt key to override Word's Grid. 

Word: Set Transparent Color  
WP: Image Tools 

 Word: 1 Word allows you to point to an area of a picture and make it 
more Transparent WP allows this via OLE.  A point to Word for 
ease of use. 

Word: Shadow  Word: 1 Word allows you to set the % of opacity/transparency of a 
shadow.  WP's is just an on/off checkbox. 



Word: 3-D Style  Word: 5 Word allows you to convert a shape into its 3-D equivalent. 

Word: AutoShapes  
WP: Shapes 

WP: 1 Word: 1 

 

 

No difference in the Shapes available, although Word did have 
this first. 

Word: Change AutoShape  Word: 1 A quick way to change a Shape from one you've chosen to 
another Shape with the same attributes.  Handy, yet I can't recall 
ever using it, so I've only given it a point. 

Word: Nudge  Word: 1 A quick way to move a shape (slightly) up, down, left, or right. 

Word: Select Object(s)  Word: 10 This is an excellent tool in Word for grouping objects.  This can 
be done in WP, but you have to point to each object and hold 
down your shift key.  It is, however, available in Corel 
Presentations, Photo-Paint, DRAW, etc., so Corel does have the 
technology, it just needs to add it to WordPerfect. 

Word: Select Multiple Objects  Word: 10 This was an Awesome NEW tool introduced into Word XP!  Click 
this icon to have a Dialog Box appear with a list of objects in your 
document; simply put a tick in the check-boxes of those you 
want, and Word selects them for you! 

Word: Grid  Word: 10 Word allows you to see a Grid on the Screen (and set options 
relating to how close the Gridlines are, etc).  This is another one 
of Word's excellent tools for Drawing. 

Word: Diagram  Word: 10 A brilliant feature (added in XP) for (quickly) creating flowcharts, 
etc. 
Yet another feature I'd love to see in WP. 

Word: Align and Distribute WP: 1 Word: 1 

 

 

Wahoo!  Corel finally adds this feature in WordPerfect 10.  I was 
hoping for the Select Tool in 11, but sadly.  .  . 

Word & WP: Chart WP: 5  Word's Charts are good.  WP's Charts are amazing—especially 
with the new engine Corel added in WordPerfect Office 2002! 

Word: WordArt  
WP: TextArt 

WP: 10 Word: 1 WP's Text Art is nothing short of phenomenal.  The 3D is 
spectacular, and the options available are extensive.  You can 
tell Corel produces WP!  Unfortunately, Corel is (overall) still 
playing catch-up with Word's Drawing features. 

GRAPHICS MENU POINTS WP: 27 Word: 61  

 
Other Items WP Word Comments 
WordPerfect: RealTime Preview WP: 10   If you read the Preamble, you'll already know what this 

feature is; if you didn't read the Preamble, then this 
WordPerfect feature allows you to see changes to your 
document in 'Real Time'.  For example, if you want to 
change the Font of your document or a selected piece of 
text, add columns, change line spacing, text size, etc., 
you 'hover' over a menu item or icon, and WP instantly 
applies the change to your document    . . .  if you don't 
like that change, hover over the next font, line spacing, 
(etc) icon; keep going until you find the one you want. 

In Word, you apply a change, don't like it, undo it, go 
back to the menu, apply another one, don't like it, undo 
it, go back to the menu, etc, etc, etc.  This WP feature 
alone saves you ages when formatting your documents. 

Word & WordPerfect:  
Task-Specific Wizards: 

WP: 10   WordPerfect has 158; Word has 4. 

Word & WordPerfect:  
Customize Keyboard 

WP: 1   WordPerfect has more capabilities. 

WordPerfect: Launch a Program from your Toolbar WP: 1   WP only.  WP allows you to add an icon to your Toolbar 
so that you can quickly launch a program.  Word allows 
you to go quickly to other Microsoft products. 

WordPerfect: Back and Forward WP: 1   WP only.  Move through documents as easily as you 
move around Web Pages.  Word has a Browse-By 
feature, but this only records edits—not clicks. 



Word & WordPerfect: AutoScroll WP: 1  Maybe this isn't as big a feature as it used to be, as most 
people probably have a wheel mouse by now, but for 
those who don't, it's good to know that this feature is 
available.  It's still hidden in Word. 

Word: IntelliSense   Word: 1 Only 1 point?  Put it this way: I have most of Word's 
'IntelliSense' features turned off.  I have had 1 example 
of it working well.  (By the way, WordPerfect has had 
'Perfect Sense' since version 6.1   . . .  PerfectSense is 
for when you change text—this ensures that text is 
always in the correct tense).   
Proof that most users DON'T LIKE Word's much-hyped 
IntelliSense feature is that Microsoft added Smart Tag 
AutoCorrect options that ask you whether you wanted 
the change that Word just made; if you didn't, you have 
the option of undoing it AND of turning off that 
AutoCorrect Feature.  Additionally, MS gave this its own 
Menu Item—again, so that people can easily stop Word 
correcting their work. 

Word: Smart Tags  Word: 1 Good idea for adding people to your Outlook Address 
Book or for scheduling a meeting on a certain date, etc, 
as MSOffice detects dates and names, then asks you if 
you want them added, scheduled, etc.  (via an icon).  In 
the 2 years since it was introduced, I haven't used it 
once.  .  . 

Word: Smart Tags (Paste) 

 

 

 

Word: 1 The other Smart Tag implementation arrived in the form 
of a Paste Icon.  When you Paste Text, a Smart Tag 
appears to the right of the pasted text—it gives you 
options that have been available in WP for as long as I 
can remember: 

Word Smart Tag WP Equivalent 
Keep Source 
Formatting 

Automatic 

Match Destination 
Formatting 

Right-Click 'Paste without Font 
Attributes' 

Keep Text Only As above 

Apply Style or 
Formatting 

QuickFonts 

 
This is a nice implementation of WP's features but it's 
more of a case of Word catching up with WP than 
anything revolutionary. 

Word: Improved International Features  Word: 5 Microsoft Office Word 11 provides improved features for 
creating foreign-language documents and for using 
documents in a multiple language setting. 
Mail Merge chooses the correct greeting format based 
on the gender of the recipient if the language requires it.  
Mail Merge can also format addresses based on the 
geographical region of the recipient. 
Enhancements to typography result in better display of 
text in more languages than ever before.  Word 11 
supports more Unicode ranges and includes improved 
support for combining diacritics. 

This feature means nothing to me, but obviously will to 
many other people. 

Word: New Look  Word: 1 OK, I know this isn't a 'wow' feature, but it's nice!  The 
new colors are soothing, cheery, and make the software 
nicer to work with.  I know that working with the new 
version of Outlook is especially enjoyable just because 
of the new look.  That may sound stupid, but it is a 
scientific fact that color affects people's mood, so why 
shouldn't software be nice-looking?  This would get 5 
points if I were comparing PIMs, as I spend so much 
time in Outlook, and the enhancements are far more 
noticeable there than in Word, but Word does deserve a 
point for the new color-scheme that Office 2003 has. 

WP: Classic Mode WP: 1  In contrast to MSO's new look, Corel discovered that 
many people liked the old DOS look of WP!  For those 



people who do (and to help people who still use WP-
DOS make the move to WP-Windows), Corel added this 
feature to let users change their keyboard and 
environment to the WordPerfect 5.1 color and keystroke 
scheme 

WP: Reveal Codes Printing WP: 5  Reveal Codes is an excellent feature for helping to 
troubleshoot documents, but everyone knows that a 
printed copy is often easier to read, and it's often easier 
to spot errors in!  Corel has, therefore, added this feature 
to WP11 to boost what is already WordPerfect's best 
feature! 

Word: Tablet PC support  Word: 1 On a Tablet PC, you can quickly provide input using your 
own handwriting directly into Office documents as you 
would using a pen and a printout. 

OK, again, this may not be a "wow" feature, and it 
probably only impacts a minority of people, but for those 
who may use it, it's probably a good feature (although I 
read that MSO's handwriting and voice-recognition 
features are not great). 

WP: Conversion Utility  
Word: Batch Convert 

WP: 1 Word: 1 Both programs now have a fast way to convert a number 
of documents in a single go. 

Word: Personalized Menus  Word: 1 When these were first introduced, I couldn't decide 
whether this was a good or bad feature.  I've read 
reviews where people said they hated them and turned 
them off.  However, after using them for several years, 
I've decided that I do like them, and I like the fact that 
they've been added to Windows.  It can be a bit 
annoying hovering over a Menu when you want to use a 
feature you don't use all the time, but if I had to choose 
whether or not to have them, I would choose to have 
them. 

OTHER POINTS WP: 31 Word: 12   

 
Menu Item WP11 Word11 WP10 Word XP WP Movement Word Movement 

File 49 22 50 12 -1 + 10 

Edit 28 15 28 7 0 + 8 

View 50 23 55 23 - 5 0 

Insert 50 17 50 30 0 - 13 

Format 128 26 140 22 - 12 + 4 

Tools 50 27 54 16 -4 +11 

Table N/A N/A N/A N/A  

Window 4 9 3 3 +1 + 6 

Help 11 3 29 3 - 18 0 

Graphics 27 61 18 45 + 9 + 16 

Other 31 12 26 14 + 5 - 2 

POINTS 427 215 453 175 Movement  - 26 Movement = + 40 

COMMENT!  As you can see, Word has made a lot of inroads in terms of points.  I could probably go into a massive analysis, but I 
think you can draw some of your own conclusions now that you've read the comparison.  What I will note is that one or two menu 
items shifted, and I was more ruthless in assigning points where I felt that a certain feature might have crossed over with another.  I 
think this is the most thorough comparison I've done yet.  I'm not deriding the fact that Word has made some inroads, has introduced 
some good features, and has worked on some other features that needed improvement, and as a result, WordPerfect's points have 
suffered.  The simple fact seems to be that Corel spent more time on stabilizing the program than they did on new features.  This is 
something that everybody wants: a more stable program.  It's therefore hard to fault Corel for doing this, but WP12 will need to move 
forward again with some new features, including those highlighted here.  Word will undoubtedly gain more features, now that XML 
has been integrated, so WP will have to keep up! 

Advantages 
Feature Later WP Users had this advantage for.  Word Users had this advantage for 



  Versions Years Versions Years 

Open Dialog Box 3 6   

Save As Web Page   1 2 

Find 6 12   

Routing Slip   1 2 

Clipboard (Cut, Copy, Paste)   1 2 

Document Map   3 6 

Application Bar 1 2   

Shadow Cursor (Point & Click) 1 2   

Task Pane/Perfect Expert 2 4   

Watermark 4 8   

Line Spacing 4 8   

Reveal Codes/Reveal Formatting 4 8   

Spell Checker 1 2   

Thesaurus 1 2   

Dictionary 1 2   

Detect & Repair   1 2 

Shapes   2 4 

Align & Distribute   2 4 

Cumulative Total Advantage  56 years  22 years 
 

 
 


